Copyright

This edition applies to version 8, release 9 of IBM® i2® Analyst’s Notebook® (product number 5725G07) and to all subsequent releases and modifications until otherwise indicated in new editions.

This edition replaces part number 2177.


US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.

Publication number GC19-3736-00
Welcome to IBM® i2® Analyst’s Notebook®.

Analyst’s Notebook is the powerful visual investigative analysis software which brings clarity to complex investigations and intelligence analysis.

This guide aims to introduce you to the key concepts and basic operations of Analyst’s Notebook. Read this guide to familiarize yourself with the software before you read the other product documentation, to learn more about Analyst’s Notebook.

Contents

What is Analyst’s Notebook? 4
Starting Analyst’s Notebook and Creating a Chart 4
Adding Entities to a Chart 5
Linking Entities 8
Adding Information to Entities 10
Saving a Chart and Adding a Summary 12
Selecting Chart Items 14
Adding Text to your Chart 15
Navigating your Chart 16
Searching your Chart 17
Using the Task Pane for Analytical Tasks 18
Listing Chart Items 20
Changing the Chart Layout 22
Adding a Legend to your Chart 23
Preparing and Printing your Chart 24
Using Data Sources 26
Notices 28

Throughout this guide, the information boxes at the end of each topic refer you to the relevant sections of the online help. Press the F1 key to access the online help while using Analyst’s Notebook.
What is Analyst’s Notebook?

Analyst’s Notebook is a powerful application that enables you to collate and visualize information from many different sources, organize it in a meaningful way, and then analyze it using a variety of techniques.

You do this by adding entities such as people, places and events to a chart, and using links to show the relationships between them. You can then explore the chart using analysis tools such as List Items, Filters and Histograms, and Social Network Analysis. In this way, you can uncover hidden information and identify possible patterns within your data.

Starting Analyst’s Notebook and Creating a Chart

When you start Analyst’s Notebook, a new, blank chart is created for you, displayed as a tabbed page in the application window.

To start Analyst’s Notebook, from the Start menu, select All Programs ➤ IBM i2 Analyst’s Notebook 8 ➤ IBM i2 Analyst’s Notebook.
Adding Entities to a Chart

You can add people, places, objects, and events to your chart in the form of entities. Each entity has a type, such as a person, vehicle or organization, and a representation. Typical entity representations are icons, event frames, and theme lines.

Adding an entity to a chart

You can use the Entity Type panel in the Add Chart Items Task Pane to drag an entity onto a chart.

Step 1
In the Task Pane, click the Add Chart Items tab.

Step 2
Click on an entity type in the Entity Type panel and, while holding down the left mouse button, drag it onto the chart.

Drag an entity type onto the chart.

The entity is added to the chart as an icon.

You can use the representation buttons at the top of the Task Pane to add entities with different representations.

To add an entity as an event frame, click the Event Frame button, then drag an entity type onto the chart.
Choosing an entity type from a different palette

Similar entity types are contained together in palettes. For example, the Commodities palette contains types such as Alcohol, Drugs, Tobacco, and so on. You can change the palette so that a different set of entity types is listed in the Task Pane.

Step 1
Click the arrow and select a palette from the drop-down menu.

Step 2
All entity types contained in the palette are displayed in the Task Pane.

Searching for an entity type

If you know the name of an entity type, you can use the Search option to locate it.

Step 1
Click the arrow and select Search from the drop-down menu.

Step 2
Start to type the entity type name in the Search box.

Step 3
As you type, matching entity types are displayed in the Task Pane.
Synonym matches may also be found.
Adding your most popular entities

If you tend to use a few entity types again and again, you can use the **Most Popular** option to quickly locate and add them to your chart.

**Step 1**
Click the arrow in the Entity Type panel and select **Most Popular** from the drop-down menu.

**Step 2**
The entity types that you use most frequently are displayed in the Task Pane.

Renaming an entity

You can change the label of an entity that you have added to the chart.

**Step 1**
Click on the entity to select it, then press the F2 key. The label is highlighted.

**Step 2**
Enter the new name and press the Enter key.

Deleting entities

To delete an entity that you have added to the chart, select it and press the Delete key.

For more information about entities, refer to the book *Working with Entities* in the *Adding and Editing Chart Items* book in the online help.
Linking Entities

Links are used to depict an association between two entities, such as a relationship or telephone call. You can add links of different types to entities to describe the association between them.

Linking two entities

You can use the Link Type panel in the Add Chart Items Task Pane to add a link to a chart.

Step 1
Click on a link type in the Link Type panel.

Step 2
Click on the first entity and, while holding down the left mouse button, drag the link to the second entity. Release the mouse button to complete the link.

Choosing a link type from a different palette

As with entity types, similar link types are stored together in palettes. For example, you can use the Telephone Call link in the Telecoms palette to link two telephone entities.

Step 1
Click the arrow and select the Telecoms palette from the drop-down menu.

Step 2
Click on the Telephone Call link type.

Step 3
Add the Telephone Call link to the two telephone entities.
**Showing the direction of a link**

**Step 1**
Right-click on the link between the two entities.

[Diagram showing a telephone call link with an arrow indicating direction]

**Step 2**
From the shortcut menu, select **Add Arrow**.

An arrowhead is displayed on the link, showing the direction.

**Reversing the direction of a link**

**Step 1**
Right-click on the link between the two entities.

[Diagram showing a telephone call link with an arrow indicating direction]

**Step 2**
From the shortcut menu, select **Reverse Arrow**.

The direction of the arrowhead is reversed.

---

For more information about links, refer to the book *Working with Links* in the *Adding and Editing Chart Items* book in the online help.
Adding Information to Entities

You can add extra information to entities and links at any time. For example, you can add a detailed description, grade and source information, and attach cards with further information.

Adding descriptions and grades

Step 1
Double-click on an icon to display the Edit Icon dialog.

Step 2
Select Description & Grades.

Step 3
To add a description, enter it in the Description box.

Step 4
To grade the information, select grades from the drop-down lists in the Grades area.

Step 5
To specify a Source Type and Reference, enter information in the Source area.

Step 6
Click OK to apply these changes.
Adding cards to an entity

Step 1
Double-click on an icon to display the Edit Icon dialog.

Step 2
Select Cards/Card List, then click New.

Step 3
Enter a summary of the card information.

Step 4
Turn on the Date and/or Time check boxes, then enter the required information. Alternatively, enter a description of the date and time, for example ‘Sunday morning’.

Step 5
Enter a description of the card.

Step 6
Enter grading and source information.

Step 7
Click OK to apply these changes.

For more information about cards, refer to the book Working with Cards in the Adding and Editing Chart Items book in the online help.
Saving a Chart and Adding a Summary

You should save your charts regularly.

Saving a chart for the first time

Step 1
From the File menu, select Save As. Complete the displayed Cover Sheet and click OK. See Adding chart summary information on page 13.

Step 2
From the Save in drop-down list, navigate to the folder in which you want to save your chart.

Step 3
Enter a name for your chart in the File name box.

Step 4
Click Save.

Saving charts regularly

Once you have saved your chart for the first time, it is good working practice to save your charts regularly.

Click the Save toolbar button to save your chart.
Adding chart summary information

You can help describe your chart to other users by completing a Cover Sheet. You are prompted to complete a Cover Sheet when you first save your chart. It can also be displayed when opening a chart, to help users read about its contents prior to opening the chart.

Step 1
Save your chart as described in Saving a chart for the first time on page 12. The Cover Sheet dialog is displayed.

Step 2
Complete the chart summary boxes to provide descriptive details.

Step 3
You can create optional custom details by clicking New and providing a Name and text Value. These could include codes specific to your team or organization.

Step 4
You can turn on the On Open check box to display the Cover Sheet every time a user attempts to open the chart.

Step 5
Click OK to save the Cover Sheet details and to continue saving your chart.

Information that you enter on the Cover Sheet, particularly Keywords, can be searched for using Windows Explorer.

For more detailed information about saving charts and displaying the cover sheet, refer to the topic Saving Charts in the Working with Charts book in the online help.
Selecting Chart Items

You can select several chart items at once. This can be useful, for example, if you want to move multiple items around the chart.

Selecting multiple items

Step 1

Hold down the left mouse button and drag the pointer down and to the right so that the items are inside the selection area.

Step 2

Release the mouse button. The items are selected.

Moving selected items

Step 1

Select one of the selected items.

Step 2

Drag the items to the required location.

For more detailed information, refer to the topic Selecting Chart Items in the Working with Items on your Chart book in the online help.
Adding Text to your Chart

You can annotate your chart using text blocks. You can also add a label to the chart, for example, to give the chart a title.

Adding a text block to your chart

Click on the **Insert Text Block** toolbar button.

Click on the chart to add the text block.

Press the F2 key and enter the text in the text block. Press the Enter key to finish.

Adding a label to your chart

Click on the **Insert Label** toolbar button.

Click on the chart to add the label; then press the F2 key and enter the title of your chart. Press the Enter key to finish.

For more information about adding text blocks and labels, refer to the book *Working with Entities* in the *Adding and Editing Chart Items* book in the online help.
Navigating your Chart

You can view a chart in different ways using the Chart Overview Window or toolbar buttons. For example, you can zoom out to see more of a chart and then zoom in on specific parts of the chart.

**Using the Chart Overview Window**

The Chart Overview Window shows a miniature copy of your chart. You can use it to navigate the chart, and to zoom in and out.

- The box shows which items are currently in view on the chart.
- Items within the box are within the viewing area of the chart. Items outside the box are outside the viewing area.
- Decrease the size of the box to zoom in to part of the chart, or increase the size of the box to zoom out.
- You can also zoom in and out using the Zoom Slider.
- Move the box around the window to navigate the chart without changing the current zoom setting.

**Using the toolbar buttons**

You can also navigate and zoom using many of the toolbar buttons.

For example, to display the whole chart in the viewing area, click the **Fit Chart in Window** toolbar button.
Searching your Chart

You can use the Search Bar, located at the bottom of the Analyst’s Notebook window, to look for a specific word or phrase contained in any chart item.

Searching for text

**Step 1**
In the box, enter the text that you want to find.

**Step 2**
Click the **Search** button.

A list of the chart items containing the text is displayed.

Viewing your results on the chart

Once you have searched for text, you can find a specific item on the chart that contains the text simply by selecting it in the list of your search results.

Click on the item in the list that you want to find on the chart.

The item is selected on the chart.

For more detailed information, refer to the topic **Using the Search Bar** in the Searching your Chart book in the online help.
Using the Task Pane for Analytical Tasks

You can use the Task Pane to carry out several useful analytical tasks—Filtering, Conditional Formatting, Social Network Analysis, and Mapping.

Filtering your chart

You can use filters based on chart item properties to select items of interest on your chart, and gray out or hide items of lesser interest.

**Step 1**

In the Task Pane, click the Filters and Histograms tab.

**Step 2**

The most relevant filters for your chart data are listed in the New page.

Click on a filter to add it to the Filters page as a list view. If a filter has (as Histogram) in its name, click on (as Histogram) to display the filter as a histogram instead.

**Step 3**

In the Filters page, click on a filter bar to apply it.

In this example, a filter has been used to select entities with a High Interest account.

Applying Conditional Formatting

You can use the Conditional Formatting Task Pane to define rules that automatically change the appearance of chart items based on their properties.

To display the Conditional Formatting Task Pane, click the Conditional Formatting tab.

In this example, a rule has been used to change the size of entities according to their link count.
Running Social Network Analysis

You can use the Social Network Analysis Task Pane to understand the most important entities and links in a network chart. For example, you can use the Betweenness measure to discover which entities may control information flow in the network.

**Step 1**
In the Task Pane, click the **Social Network Analysis** tab.

**Step 2**
In the Results Page, click **Calculate:** Betweenness.

**Step 3**
The betweenness results are displayed as a sortable list in the Task Pane.

Click on a result to pan to that entity on the chart.

Sending chart items to Google Earth

If you have Google Earth installed on your computer, you can use the Map Chart Items Task Pane to view entities with coordinates or addresses on a Google Earth map.

**Step 1**
In the Task Pane, click the **Map Chart Items** tab.

**Step 2**
Select the items on your chart with geographic information and, in the Sent Items page, click **Send Chart Items**.

**Step 3**
In Google Earth, the mapped items are displayed with their Analyst's Notebook icons.

If you don't have access to Google Earth, you can export your mapping data as a Kml or Kmz file for use with a different mapping application.

For more detailed information, refer to the **Filtering the Contents of your Chart**, **Conditional Formatting**, **Social Network Analysis**, and **Mapping Chart Items** books in the online help.
Listing Chart Items

You can list all of the entities and links in your chart, in table form, using List Items. For each entity or link listed, additional columns of information are provided which enable you to group and analyze the items. You can filter out or delete the items you are not interested in, and sort selected columns of interest.

Viewing List Items

Step 1
From the Analysis menu, select List Items. The List Items dialog is displayed.

Click on a column header to group the entities or links by their column values. For example, you can group all Accounts together by clicking Type.

Selecting an item also selects the item on the chart, when you click OK. This is useful in pinpointing items in large charts.

You can select which columns you want displayed.

You can keep selected items in the list that you want to analyze, and filter out those that you are not interested in, or delete selected items.

Separate pages are provided for the analysis of entities and links. All of the grouping, column display, and filtering options are available on both pages. Click the relevant tab to switch between pages.

Step 2
Select the entities or links that you are interested in, and click OK.
Sorting List Items

In the List Items dialog you can sort the contents of columns in ascending order, and choose up to three columns to sort.

Step 1
From the Analysis menu, select List Items. The List Items dialog is displayed.

The Label column is sorted in alphabetical order initially. Numbers are sorted first.

Step 2
Click Sort to display the Sort dialog.

Step 3
Select which columns you want to sort from the Sort by and Then by drop-down lists, and select the sort order. You can select up to three columns to sort. This example sorts the entity Label column and then the entity Type column in ascending order.

Step 4
Click OK to sort the selected columns.

After sorting, the column headers indicate which columns are sorted, and their order.

For more detailed information, refer to the book Working with List Items in the Listing the Contents of your Chart book in the online help.
Changing the Chart Layout

Layouts provide a quick way of rearranging the entities and links on your chart to improve the chart's appearance and to help you view the chart more easily. For example, the chart items can be rearranged to reduce the number of crossed links as much as possible.

Applying the Minimize Crossed Links layout

Step 1
Open the chart that you want to apply the layout to. This chart contains numerous crossed links.

Step 2
Click the Minimize Crossed Links Layout toolbar button.

The chart is rearranged to minimize the number of crossed links.

For more detailed information, refer to the Rearranging the Layout of your Chart book in the online help.
Adding a Legend to your Chart

You can add a legend to your chart to provide a key to the entity types, link types, and other features used. For example, certain links types may have been used for a specific purpose, and you can describe this use in the legend. The legend can be created and populated automatically, which you can later edit.

Automatically creating a legend

Step 1
From the **Format** menu, select **Legend**. The Legend Population Option dialog is displayed.

Step 2
Click **Yes** to populate the Legend automatically. The Edit Legend dialog is displayed.

You can add a title to the legend.
You can double-click on an entry to change its description.
You can add new legend entries, for example a new link entry.
You can re-order the entries in the legend.

Step 3
Make the changes you require to the entries, and click **OK** to add the legend to your chart.

Once you have added a legend to your chart, you can move its position.

For more detailed information, refer to the book *Working with the Legend* in the *Preparing your Chart for Distribution* book in the online help.
Preparing and Printing your Chart

To print your chart, you need to select a paper size and specify how the chart will fit on the paper. The Best Fit option typically gives the best result.

Preparing your chart for printing

**Step 1**
From the **File** menu, select **Page Setup**.

**Step 2**
Select a printer.

**Step 3**
From the **Paper Size** drop-down list, select your paper size.

**Step 4**
In the Orientation area, select **Portrait** or **Landscape**.

**Step 5**
Click **Adjust**, then select **Best Fit**.

**Step 6**
Click **OK**.
Checking your chart before printing

Once you have closed the Page Setup dialog, you will see that your chart is enclosed in a box. This is the page boundary which shows how your chart will be printed.

The example chart is surrounded by a single page boundary. This means the chart will print on a single page.

This example chart is much larger and will print across four pages. The dotted lines divide the chart into four pages.

If you want to change the area of the chart that will be printed, you must open the Page Setup dialog again and change the settings.

Printing your chart

Click the Print toolbar button to print your chart.

Other methods of publication and distribution

You can also save a chart as a picture for use in your documents and reports, or export it as a PDF document.

To save a chart as a picture, from the File menu, select Save as Picture. You can save it as a gif, jpg, png, tif or bmp file.

To export a chart as a PDF, prepare the chart for printing as described on page 24, then from the File menu, select Export to PDF.

For more detailed information about printing and distributing a chart, refer to the Preparing your Chart for Distribution book in the online help.
Using Data Sources

You can take data from a supported data source to which you subscribe, and add it to your chart. The information can be presented using entities and links, and it can be refreshed against the original data.

Searching for data

Step 1

From the Data menu, select the data source you want to connect to, then select Search.

Note: To add a data source to your Data menu, select Online iLink ➦ Configuration.

The data source appears in your Web browser. This is an example of what the Web page might look like.

Step 2

Run your query on the data source Web page. You will need to refer to your own specific data source for instructions on how to run the search.

The information is displayed in the browser as chart items.
Adding the data to your chart

You can drag and drop the information that you have found from the data source Web page, into your chart.

Step 1
Click on the items in your browser to select them.

Step 2
Drag them onto your chart.

Analyst’s Notebook also allows you to import data from spreadsheets and from a wide range of file formats using the Importer.

For more detailed information, refer to the Working with Databases and Data Sources book in the online help.
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk,
NY 10504-1785
U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice. This information was developed for products and services offered in the U.S.A.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

*IBM United Kingdom Limited*

*Hursley House*

*Hursley Park*

*Winchester,*

*Hants,*

*SO21 2JN UK*

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.
Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Other names may be trademarks of their respective owners. Other company, product, and service names may be trademarks or service marks of others.

Contacting support

IBM Support provides assistance with product defects, answers FAQs, and helps users resolve problems with the product.

Before you begin

After trying to find your answer or solution by using other self-help options such as technotes, you can contact IBM Support. Before contacting IBM Support, your company or organization must have an active IBM software subscription and support contract, and you must be authorized to submit problems to IBM. For information about the types of available support, see the Support portfolio topic in the "Software Support Handbook".

Procedure

To contact IBM Support about a problem:

1. Define the problem, gather background information, and determine the severity of the problem. For more information, see the Getting IBM Support topic in the Software Support Handbook.

2. Gather diagnostic information.
3. Submit the problem to IBM Support in one of the following ways:

   Online through the IBM Support Portal: You can open, update, and view all of your service requests from the Service Request portlet on the Service Request page.

   By phone: For the phone number to call in your region, see the Directory of worldwide contacts web page.

Results

If the problem that you submit is for a software defect or for missing or inaccurate documentation, IBM Support creates an Authorized Program Analysis Report (APAR). The APAR describes the problem in detail. Whenever possible, IBM Support provides a workaround that you can implement until the APAR is resolved and a fix is delivered. IBM publishes resolved APARs on the IBM Support website daily, so that other users who experience the same problem can benefit from the same resolution.

How to send your comments

Your feedback is important in helping to provide the most accurate and highest quality information. To submit any comments about this book or any other documentation, send your comments by email to ibmi2doc@uk.ibm.com.

Be sure to include the name of the book, the part number of the book, the version of the software, and, if applicable, the specific location of the text that you are commenting on (for example, a page number, table number, or a heading).